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This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the  
interference by one or more of the following measures : 
�
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Thank You 

Thank you for purchasing the i-pen Mouse. You have made an excellent choice for your next digital input device. i-pen 

Mouse is designed to be used for many functions with ease. 

 

Trademarks 

The following are registered trademarks of FingerSystem Inc.: i-pen, i-pen logo, and FingerSystem logo. 

 

FingerSystem is a trademark of FingerSystem Inc. Other product names mentioned in this guide may also be 

trademarks or registered trademarks of their respective owners. 

 

Proprietary Statement 

The digitally encoded software included with your i-pen is Copyrighted © 2003 by FingerSystem Inc. All Rights Reserved. 

This software may not be reproduced, modified, displayed, transferred, or copied in any form or in any manner or on any 

media, in whole or in part, without the express written permission of FingerSystem Inc. 

 

Copyright Notice 

This manual is Copyrighted © 2003 by FingerSystem U.S.A., Inc., 9237 Eton Ave., Chatsworth, CA 91311. All Rights 

Reserved. This document may not be copied, in whole or part, not transferred to any other media or language, without 

written permission of FingerSystem U.S.A., Inc. 

 

Manual Notice 

FingerSystem U.S.A., Inc. reserves the right to make changes to this manual and to the equipment described herein 

without notice. Considerable effort has been made to ensure that this manual is free of inaccuracies and omissions. 

However, FingerSystem U.S.A., Inc. makes no warranty of any kind including, but not limited to, any implied warranties 

of merchantability and fitness for a particular purpose with regard to this manual. FingerSystem U.S.A., Inc. assumes no 

responsibility for, or liability for, errors contained in this manual or for incidental, special, or consequential damages 

arising out of the furnishing of this manual, or the use of this manual in operating the equipment, or in connection with 

the performance of the equipment when so operated. 

 

Registering i-pen Mouse 

Mail – Fill out and send in the registration card enclosed in your shipment. 

Online – Go to http://www.fingersystemusa.com/registration/ 
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Description 

 
i-pen Mouse is a pen-shaped mouse that enables users to control a PC and input handwriting. In particular, it allows 

natural handwriting just like using a real pen by sensing its contact pressure with the work surface. 
Utilizing the recent optical navigation technology and the mouse-hover technique, i-pen Mouse is lightweight and 

durable. 
Especially, because i-pen Mouse requires very small surface to write on, it is very ideal for notebook users and 

perfect for places with limited workspace is allowed. 
 
Shipment Contents 

� i-pen Mouse 
� CD including a driver, application software, and documentation. 
� Documentation (see “Documentation Set” below) 
� Extra Pen Tips (2 included) 
� Complimentary i-pen Mouse Pad 

Features 
� Optical navigation & mouse-hover technology. 
� "Pen-on-paper" feeling: Natural handwriting. 
� Compact and light: Perfect for laptop users. 
� Special pad required. 
� High fashionable design: Fits comfortably on your hand. 
� USB connection: Just plug and play. 
� Low-battery indicate. 
� Battery level display in charging. (3-step:green->full, orange->middle, 

red->low) 
� Includes two application software: Web-Memo™ & Finger-White™ 
� 1 Year Limited Warranty 

Specifications 
� Size  - Transmitter : 157mm (L) X 13mm (W) X 30mm (H). 
          - Receiver : 108mm(L) X 49mm(W) X 42mm(H). 
� Wire length : 1.7M(1.2M) 
� Weight  - Transmitter : 40g - Receiver : 100g(With cable) 
� Connection: USB 
� Resolution: 400 dpi 
� Power: Transmitter : 3.7v battery,Receivr:5V (using PC power via USB port) 
� Body Color: Blue 
� Pen Tip: Soft Micro Switch 
� In-use time: 5.5hours 
� Stand-by time : 26hours(power save:80hours) 
� Active distance : in the 15m radius. 

Bundled Softwares 
� Web-Memo™ 
� Finger White™ 
� ritePen™ 
� riteMail™ 

Documentation Set 
� Quick Usage Guide – Use this sheet to quickly use i-pen Mouse. 
� User’s Guide – You’re looking at this document right now. This assists in setting up the i-pen Mouse, 

installing a driver and software. 
� Warranty Information – Information about product warranty and warnings. 
� Registration Card – Please register your product for future updates and support. 
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System Requirements 
 

i-pen Mouse requires the following minimum system configuration: 
 

� At least a Pentium CPU or equivalent 
� Microsoft Windows 98/Me/2000/XP 
� An available USB port 
� An available CD-ROM drive (to install driver and software) 

 
Installing i-pen Mouse Driver and Softwares 
 

The CD includes i-pen Mouse driver and application softwares. Please follow the instructions below to install the 
driver and software. This instructions will install i-pen Mouse driver as well as Web-Memo™, Finger White™, ritePen™, 
and riteMail™. 

 
1. Plug in the i-pen Mouse to an available USB port. 
2. Insert the Driver and Software CD into a CD-ROM drive on your computer and the CD will automatically run. 
3. When the installation application window appears, select the language of your choice, and then follow the on-

screen instructions. 
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4. When prompted to select the options, only check the last four boxes, leaving the top box unchecked. First box is 

for i-pen Mouse PS2 version and does not apply to USB. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please click “Yes” or “Continue Anyway” to continue installation process. 

 

Windows 2000 Windows XP 

NOTE: Warning message may pops up as shown in the diagrams below   

when installing the i-pen Mouse driver. The warning message pops up because 

the driver is new and has not yet received the Microsoft certificate for driver 

compatibility. We are currently in the process of acquiring the certificate within a 

short time. You may ignore the warning message and continue with the 

installation. The driver and softwares will not damage your system. 
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Windows 98 Second Edition 
 
Installing USB Human Interface Device 
 

1. Connect the i-pen Mouse to an available USB port on your computer. Add New Hardware Wizard will be 
prompted, then click Next. 

 

 

2. Select “Search for the best driver for your device. (Recommended).” and click Next. 

 



 

2400 MHz WIRELESS OPTICAL PEN - MOUSE 
MODEL : I-PEN PRO                     

I    S    V  

 

3. Uncheck all the selection and click Next. 

 

 

4. The driver will be automatically searched. Click Next to continue. 
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5. Click Finish to continue. 

 

6. When prompted to insert the Windows 98 Second Edition CD-ROM, insert the CD and click Next. 

 

7. Click Finish. 

 

 

8. Insert the Driver and Software CD and follow the instructions in page 2. 



 

2400 MHz WIRELESS OPTICAL PEN - MOUSE 
MODEL : I-PEN PRO                     

I    S    V  

 

Using i-pen Mouse 

 
i-pen Mouse is used for operating your PC like a mouse, 
to write a memo and to draw. 
i-pen Mouse has two buttons for operation. The first button (also called a pen-tip button) is the pen tip of i-pen Mouse 
and its function is same as the left button of a mouse. The second button (also called a push button) is the button 
located on the front top of the i-pen Mouse and its function is same as the right button of a mouse. 
 
Helpful Tips on Using i-pen Mouse 
Good Posture of holding i-pen Mouse 

 

 

 
When you use a ball-point pen, you can write a letter on a paper irrespective of the posture of holding it. Contrarily, if 
you hold a fountain pen and rotate its pen tip to an upright position, you cannot write a letter at all, because the pen tip 
of a fountain pen has different structure from that of a ball-point pen. 
Similarly, the performance of i-pen Mouse greatly depends on the posture of holding it as that of a fountain pen does. 
As a result, when you try to write a memo or draw a simple graph with i-pen Mouse, the bad posture of holding it may 
result in unexpected output such as rotated letters, tilted axis and so on. Therefore, you should be careful when holding 
the i-pen Mouse. 
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A good posture of holding the i-pen Mouse is shown in the figures below. The forepart, where the push button is 
attached, should face the front. 

 

 

 
If the angle of i-pen Mouse and the surface is too low as shown in the figure (a), or if its forepart does not look to the 
front as shown in the figure (b), (c), and (d), it will not work very well. 

 

 

 

 

 

 

 



 

2400 MHz WIRELESS OPTICAL PEN - MOUSE 
MODEL : I-PEN PRO                     

I    S    V  

 
Optical Character Recognition (OCR) 

You can use ritePen™’s OCR function to convert your handwriting into a computer text. OCR function allows you to 
input your handwriting and convert it to a computer text. Now you can write long document and e-mail using i-pen 
Mouse like a pen with ease. Perfect for those who don’t know how to type or those who are just too slow to type that 
long message. 
 
i-pen Mouse Pad 

While i-pen Mouse works well on almost any surface except for a glass plate and white paper, it is recommended 
that you use i-pen Mouse on a mouse pad provided for smoother surface. 
 
 
Using i-pen Control Center 
 
After successfully installing the i-pen Mouse driver, i-pen Control Center icon will appear on your system tray as shown 
below. 

 

 

 

 

 

You can switch between a mouse mode and a pen mode by clicking on the i-pen logo as shown below. 

 

 

 

 

 

 
Select i-pen Setting to change more options for your i-pen Mouse. 
 
When you have successfully installed i-pen Mouse driver, three additional tabs will appear on your mouse settings 
properties. You can toggle between a Mouse mode and a Pen mode. You can adjust the sensitivity by moving the 
scales left to right. Set the sensitivity to which you feel most comfortable using i-pen Mouse. 
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Speed 

You can use i-pen Mouse as a “Mouse” by setting the acceleration 
faster on a Mouse mode. The default acceleration setting is at 50. You can 
adjust the acceleration to which you feel most comfortable with. 

When “Pen” mode is selected, a different acceleration scale will show. 
You can set a different acceleration speed for Mouse mode and Pen mode. 
This will help you use i-pen Mouse better for drawing or writing. The 
default acceleration setting is at 50. 

The recommended value of Pen mode is below 50, and higher value for 
Mouse mode.  

 
 
 
 

Double Click 
This setting allows you to adjust the double clicking action using the i-pen Mouse. 
Move your cursor to the target diagram and click twice. The value in a small dialog box will change. The upper one 

shows you the interval between your first click and second click. The small box below will show the range between two 
clicks.  

It will be helpful to have several clicks on the target diagram. The double click time and range values will appear 
accordingly. Choose the best settings for you. 

 

i-pen Info 

An overview of i-pen Mouse and manufacturer information is shown here. 
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Using Web-Memo™ 

 
Using the Web-Memo™ you can write a note and draw a diagram on the website like a paper. Highlight your favorite 

sports page, write a remark, underline and mark an error. 
Even if you surf to other webpage, all the information you wrote and drew on the webpage will reappear when you 

access the same webpage again. 
 
Required Environments 

Operating System: Microsoft Windows 98/Me/2000/XP 
Web Browser: Microsoft Internet Explorer 5.5 or later 

 
To use the Web-Memo™, open Internet Explorer. If Web-Memo™ is installed correctly, its toolbar should be 

displayed below the address bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Internet Explorer Window Using Web-Memo™ 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: If the toolbar is not shown, place the cursor on the empty space of the 

tool bar of Internet Explorer window and click the push button of i-pen Mouse 

once, then check FingerSystem IE Memo from the pop-up box. The long 

lb ill h f I E l h i h fi b l
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Tool Selection Pallet 

 

 

 

 
IE Mode: To allow normal web browsing capability, have this box pressed. To use the Web-Memo™ 
function again, choose the tool of your choice from the toolbar. 
 
New Memo: All of the memos written on the current webpage will be erased by clicking this button. 
 
Capture: You can save a portion of the current webpage you want into a html format. Once saved, you 
can retrieve the file later at your choice. 
 
Select: Both the memos and drawings written on the web page are treated as an object. If you want to 
move an object to the different position, just click and drag the object. 
 
Erase: You can erase a single object with a click. Place your cursor over the object you want to erase 
and click on it. 

 
Color Picker: You can use this tool to select the color of a point you click on. Use this tool if you want to 
select a color that’s on a webpage. 
 
Highlight: If you click this button in the Web Browser mode after selecting a portion of the text area, its 
background color will be changed to the pre-specified color and be highlighted. 

 
Drawing Tools: After you select a tool from the drawing tools, you can draw the object on the webpage freely. 

 
Marking Pen Line Rectangle 
 
 
Filled Rectangle Ellipse Filled Ellipse 
 

   
Pen Thickness: Change the line thickness of an object to be written. 

 
   
Color: You can select the color of an object to be written. 
 
Memo List: This shows the list of webpage that you’ve written on. You can select from the list to 
bring up that webpage. 
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Using Finger White™ 
 

Using Finger White™ you can write notes, draw, mark and underline corrections on almost anything that shows on 
your screen. Leave a short note or a schedule on your computer’s desktop, leave a mark or a comment on a 
presentation, and any writing you would want to leave on the screen. 
 
Finger White™ Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Finger White™ System Tray Icon 
 

When Finger White™ is running, you’ll see an icon on the system tray. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: If the marking doesn’t stay on after you’ve written a memo or drawing, 

please click on the Finger White� icon on the system tray and select Show... 

t ti t Fi Whit � th ti h b l S l t Q it
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Tool Selection Pallet 

 

 

Help: Click this button 

when you need help on using Finger White™. 

 

 

 
Reload: When memo window is behind other window or if you want to redraw the memo, press this button. 
 
 
New Page: Delete all memo on current page. 
 
 
Previous/Next: Go to previous or next slide when used on Microsoft PowerPoint. 
 
 
Capture Screen: Save selected area on current screen to image. 
 
 
Save Screen: Save full area on the current screen to image. (image only) 
 
 
Select Object: You can select an object and move it to a different location. 
 
 
Erase: You can erase a single object by clicking on the object. 
 
 
Color Picker: You can click on the spot you want to pick the color of. 

 
 
Drawing Tools: After you select a tool from the drawing tools, you can draw the object on the screen freely. 
 
Marking Pen Magic Pen Line Rectangle 

 
 

Filled Rectangle Ellipse Filled Ellipse 
 

 
Pen Thickness: Change the line thickness of an object to be written. 

 
   
Color: You can select the color of an object to be written. 
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Using ritePen™ (Applicable for English Only) 
 

ritePen™ is a next-generation handwriting recognition tool. With ritePen™, users can write on the full screen using 
the i-pen Mouse. ritePen™ instantly converts English language handwriting into text and enters the text into any 
Windows application, such as Microsoft Word, Word Pad, Notepad, Excel, Outlook, File Manager, Internet Explorer, etc. 
 
System Requirements 

Processor: At least a Pentium 400MHz or equivalent 
Memory: 64MB RAM or more 
Display: SVGA (800 x 600) or better 
Input Device: i-pen Mouse 
Operating System: Microsoft Windows 98/Me/2000/XP 

 
ritePen™ Window 

 

 

 

 

 

 

 

 

 

 

 

 

 < Handwriting Input > < Result > 

 

 
ritePen™ System Tray Icon 
 

When ritePen™ is launched, you’ll see an icon on the system tray. Tap and hold ritePen™ icon to open the Menu. 
Menu items are self-explanatory. Pen On is checked when ritePen™ is enabled and unchecked otherwise. 
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ritePen™ Settings 
 

You can change timeouts for text selection and writing in this dialog box.  
 
Timeout for Selection: When you select a portion of text by pressing and dragging your pen across the selection, 
ritePen™ briefly draws an ink stroke. By changing timeout for selection, you shorten the time this stroke appears on the 
screen. 
 
Timeout for Writing: When you are entering text using ritePen™, the application recognizes your writing continuously. 
When you lift a pen after you completed a portion of writing and want the text to appear in the target application, 
ritePen™ waits for a short while to give you the opportunity to put dots over “I”’s or cross your “t”’s. In order to speed up 
the recognition process, you may shorten this time, which is set at the experimental comfort level of 1200ms. In case 
you set this timeout at a lower level, you need to make sure that the timeout is sufficient for you to put the 
dots/crosses/diacritic signs when they are present in the handwritten text. 
 
Enable Recognizer Fusion: Not Applicable for i-pen Mouse. 

 

 

 

 

 

 

 

 

 

 

 

 

 
ritePen™ Toolbar 
 
You can change pen style, width and color using ritePen Toolbar. Pressing the arrow in the ritePen toolbar disables the 
writing capability and is equivalent to tapping the ritePen icon in the taskbar. 
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Using riteMail™ 
 

riteMail™ is the first unified note taking application that enables users to take handwritten notes on i-pen 
Mouse,  transmit notes to any email address, and then process and recognize them on desktops. 
 
System Requirements 

Processor: At least a Pentium 400MHz or equivalent 
Memory: 128MB RAM or more 
Display: SVGA (800 x 600) or better 
Input Device: i-pen Mouse 
Operating System: Microsoft Windows 98/Me/2000/XP 
Internet Connection: TCP/IP 
Web Browser: Microsoft Internet Explorer 5.5 or later 
E-Mail: Your regular desktop e-mail application (Outlook, Eudora, etc.) 

 
riteMail™ Window 

 

 

 

 

 

 

 

 

 

 

 

 
How to Use riteMail™ 
 
1. Opening Files: Open a riteMail™ notes file (.itp file) from the Notes File List. 
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Or open a handwritten message somebody has sent you from a Mail Folder. 

 

 

 

 

 

 

 

 

 

 

 

 
Right click on the "Notes" or "E-mail" bar to open a pop-up menu with Notes Folder Setup or Mail Setup, and Field 

Chooser. The Notes Folder Setup allows you to change the default notes folder. The Mail Setup allows you to choose 
the default mail client and the delivery method for riteMail™ messages. The Field Chooser helps you alter display of 
Notes and Mail folders by adding or deleting fields. 
2. Selecting Ink: Select a portion of electronic ink by clicking the Selector  button and either encircling, clicking, or 
crossing strokes. To select additional portions (including non-contiguous portions) hold the Shift key. To unselect 
a portion, hold the Alt key. The selected portion appears in a "faded" color as shown below. 

 

 

 

 

 

 

 
3. Copying/Pasting Ink: Press Ctrl-C or the Copy button  to save the selected ink to the Clipboard. You can 
paste it to the same or a new riteMail™ note or to Microsoft Word, Excel or PowerPoint. To paste the ink from the 
Clipboard, Press Ctrl-V or the Paste button. In the Microsoft Office documents, you can also select "Edit > Paste 
Special" to choose between pasting the ink as a bitmap or as an editable vector object (enhanced metafile). 
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4. Recognizing text: With handwritten text selected, choose "Edit > Copy as Text" to recognize handwriting using 
riteScript™ technology, and save the results to the Clipboard. 

 

 

 

 

 
5. Recognizing Shapes and Charts: With Shapes or Charts selected, press the riteShape™ button  (or right-
click on the selection and choose Shape Up) to perfect shapes on the spot. You can later copy and paste recognized 
shapes and charts into office documents as explained in 3 and 4 previously. 

Alternatively, you can click the riteShape™ button at any time and draw shapes or charts that will be instantly 
perfected. Don't forget to click on the riteShape™ button again to disable shape recognition when you return to writing 
and freehand drawing. 

 

 

 

 

 

 

 

 
 
6. Changing Ink Color/Style: You can resize, drag, and cut-copy-paste selected ink within a riteMail™ document or 
between documents. You can also change ink color, widths, or pen styles in selected ink by right-clicking on the 
selection and choosing Change Color, Change Width, or Change Style or by clicking on the appropriate buttons on 
the Toolbar. 
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8. E-mailing Notes: Before e-mailing a handwritten note, you must be registered with the riteMail™ service and 
complete the user info at “Tools > Options > User”. 
To send a message, click the Send icon , enter the To and Subject information, and press the Send 
button    to the right. 

 

 

 

 

 

 

 

 

 

 
Toolbars 
 
File Menu 

 

 

 
New - Create a new document. 
Open - Open an existing document. 
Save - Save the active document. 
Save As - Save with a new file name. 
Delete - Delete the current document. 
Reply - Reply to the sender for the current document. 
Reply to All - Reply to sender and all recipients of the current document. 
Settings - Change paper and grid color and turn horizontal and vertical grid lines on and off, as seen in this dialog box: 
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Print - Print the current document using “Smart Print” feature that intelligently determines where to place uneven page 
breaks. 
Preview - Preview the current document, showing the “Smart Print” page breaks, and allowing user manipulation of 
those page breaks. 
Print Setup - Change the printer and printing options for the current document. 
File History - Select and open recent files. 
Exit - Quit this application; prompts to save documents. 
 
 
Edit Menu 

 

 

 
Undo - Undo the last action. 
Cut - Cut the selection and put it on the clipboard. 
Copy - Copy the selection and put it on the clipboard. 
Copy as Text - Copy the selection as recognized text rather than as electronic ink. 
Paste - Insert electronic ink copied to the clipboard from the current file or another riteMail™ file. 
Delete - Delete the selection. 
Select All - Select all content of the active document. 

 

 

View Menu 

 

 

 
View Toolbars - Show or hide the Main, Tools, and Send toolbars. 
Notes - Show or hide the Notes List. 
Mail - Show or hide the Mail List. 
Status Bar - Show or hide the Status Bar at the bottom of the screen. 
Refresh - Redraw the Notes and Mail file lists. 
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Tools Menu 

 

 

 

 

 
User > First Name - Enter user's first name. 
User > Last Name - Enter user's last name. 
User > Email Address - Enter email address in this format: <user>@<domain> 

 

 

 
Message > Default Paper Color - Select the default background paper color from the color palette. 
Message > Default Grid > Horizontal - Change the horizontal grid default: Check to view, uncheck to hide horizontal 
grid, and select grid separation distance. 
Message > Default Grid > Vertical - Change the vertical grid default: Check to view, uncheck to hide vertical grid, and 
select grid separation distance. 
Message > Default Grid > Color - Select the default grid color from the color palette. 
Message > Default Tool > Tool - Select the tool to be active by default:  Pencil, Pen, Whiter, Cutter tool, or Selector. 
Message > Default Tool > Width - Select the default pen width from the pull-down menu. 
Message > Default Tool > Color - Select the default pen color from the color palette. 
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Mail Setup > Receive Using > Default mail client (Microsoft Outlook) - Click Advanced to change this default to 
another mail client. 
Mail Setup > Send Mail > Use riteMail Service - Check to use the riteMail™ service. 
Mail Setup > Send Mail > Send using - Enter name of the mail server for your computer. 

 

 

 

Notes > Default Notes Folder - Click Browse... to change this default. 

 

 

 
Margins > Top, Bottom, Left, Right - Scroll or enter a number to change this default. 
Header > Print message subject - Check to print the subject of the message as a header 
Header > Text Font - Click to change the header font. 
Footer > Print page number - Check to print the message page number as a footer. 
Printer setup... - Click to change the Printer properties, paper size and source, and orientation. 

 

 
Window Menu 
 

 

 
New Window - Opens another instance of riteMail™ for Windows, displaying a blank message. 
 
 
Help Menu 

 

 

 
riteMail™ Help - Loads riteMail™ for Windows Quick Start Guide. 
About riteMail™ WinClient - Displays riteMail™ for Windows version number and copyright information. 
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Troubleshooting 

 

Although i-pen Mouse is designed to be highly reliable, you may occasionally experience a problem. The following 

helps you to identify the cause of the possible problems and suggest some solutions related to the problem. 

 

Symptom Cause Solution 

i-pen Mouse cursor is not moving. USB cable is not properly connected 

to the USB port. 

Unplug the USB connection and 

plug it again properly. 

 Something is wrong with your USB 

port. 

Plug in another USB device into 

the USB port and test if it works. 

 i-pen Mouse Driver is not installed 

correctly. 

Reinstall the i-pen Driver and 

reboot your PC. 

 USB is not enabled or the driver is 

corrupted or deleted. 

Check your CMOS settings for 

USB and the driver for USB port in 

Windows. 

 The ID-DATA of transmitter and 

receiver is not equaled correctly 

The ID-SETTING is required again. 

The transmitter is placed on the 

receiver for 1~2 second. 

 Transmitter’s power reset is not 

correct 

Retry the power switch off/on. 

 The transmitter is low battery. The transmitter charge on the 

receiver. 

i-pen Mouse cursor moves but the 

clicking function is not working. 

There is a problem with the USB 

connection. 

Check the USB connection and 

plug in the USB connector again. 

 The pen tip of i-pen Mouse may be 

damaged. 

Replace the pen tip with a spare 

pen tip provided with the i-pen 

Mouse package. 

i-pen Mouse sensitivity is too high. The acceleration level for i-pen Mouse 

is set too high. 

Go to the i-pen Settings and set 

the acceleration level to which you 

feel most comfortable with. 

i-pen Mouse is not writing or drawing 

as I want it to. 

i-pen Mouse is not operating on a flat 

smooth surface or its provided i-pen 

Mouse pad. 

Use the i-pen Mouse on a pad 

provided with the i-pen Mouse 

package for the best result. 
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Contact & Support 
 

 
 

FingerSystem technical support team is eager to help you enjoy your new FingerSystem product. if you are 
experiencing difficulties, please contact us with the following methods for support: 

 
U.S.A. 

 
Address: Finger System U.S.A., Inc. 
 9237 Eton Ave. 
 Chatsworth, CA 91311, U.S.A. 
 
Phone: 818-727-0090 
Fax: 818-727-0999 
Website: http://www.fingersystemusa.com/ 
 

 
Europe 
 
 Address: Finger System Europe GmbH 

Max-Eyth-Str. 7  
Germany - 70376 Fellbach  

   
 
 Phone: +49-711-5056784 
 Fax: +49-711-5056785 
 Website: http://www.fingersystemeurope.com/ 
 
 
Asia 
 
 Address: Finger System Inc. 
  202 Dae Young B/D #515-6 Sinsa-dong, 
  kangnam-ku, Seoul, Korea 
 
 Phone: +82-2-518-3893 
 Fax: +82-2-518-3895 
 Website: http://www.fingersystem.com/ 
 
Do you have any comments or suggestions? If so, we love to hear from you! Please visit our website and fill out the 

contact form or you can send us a mail to the address above. Your comments and suggestions help make our product 
better and enhanced to fit your needs. 
 
 

Thank you for purchasing FingerSystem product! 
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